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This page presents to you the most important Maple commands and functions available, so that

you can try out Maple’s capabilities even if you have not yet worked with this system before.

Indeed, it is an introduction on the fast run; if you like to use Maple regularly and in all its aspects,

it is inevitable studying the online help and books.

You can use this course with Maple 6 and 7, and also in Maple V Release 3, 4, and 5 (see
remarks).
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Editing

After starting Maple a prompt in the current worksheet appears, which marks an input line for
Maple commands.

You can switch between neighboring input lines by using the keys Up and Down.
The cursor keys left and right allow you to move in an input line.
You can insert characters with the INS or delete them with DEL keys.

Expressions or parts of them can be copied to the clipboard using CTRL+C and be pasted with
CTRL+V at any position.

Inputs are terminated with a semicolon (except when calling the online help), by pressing the
RETURN key Maple computes the result and displays it.

Opening and saving worksheets

To open worksheets in Maple 7 click on the ‘File* menu and choose the ‘Open’ item.
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To save a worksheet so that you can use it in another session, click on the *File* menu and then

choose the ‘Save As' item.
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Representation of mathematical expressions

You can use the following operators and functions to enter mathematical expressions:

file:///El/homepage/mpl crashcourse.htmm

16.12.01 19:44



Maple bilingual - Crash course to Maple

40f 17

]Basic operators
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addition +
'subtraction -
'multiplication *
division /

\exponentiation

\Elementary functions

]Square root

]sqrt (x) orx”(1/2)

nth root

surd(x, n) orx”(1/n)

Exponential function to the base

e=2.7182818... exp(x)
]Logarithm to the base a ]I og[ a] (x)
Natural logarithm 1 n(x)

\Trigonometric functions

\si n(x),cos(x),tan(x),sec(x),cot(x),csc(x)

Hyperbolic functions

si nh(x),cosh(x),tanh(x),sech(x),csch(x),
cot h( x)

Inverse trigonometric functions

arcsin(x),arccos(x),arctan(x),arcsec(x),
arccsc(x),arccot (x)

Inverse hyperbolic functions

arcsi nh(x),arccosh(x),arctanh(x),
arcsech(x),arccsch(x),arccot h(x)

/Absolute value

abs(x)

'Sign

sgn(x)

Maple knows general precedences, e.g. 3*4+ 1 =12+ 1 =13, but 3* (4+1) =3 *5 = 15. In Maple,
as in mathematics, almost all other programming languages and with pocket calculators, use

brackets to set other precedences.

Your first Maple example:

> 3*4+1;

> 3% (4+1);

Plotting curves

13

15

Now having read this, enter the polynomial X2-2x+1. Keep in mind that in Maple powers are
expressed with the caret (*). Multiplication is always represented using the * operator.

> XN2-2*x+1;

><2—2><+’1

You can store this expression in a variable, so that you can refer to it in session again and again
by calling its name. Allocate expressions to a variable - here p - by using the characters : =, a
colon directly followed by an equals sign.
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> p = XN2-2%x+1;

p::x2—2x+’l

Displaying the graph is often very helpful to estimate characteristics and behavior. The most basic
plotting function is plot.

> plot(p, X);

This means that the expression p in the unknown x is plotted. By default, Maple uses the x-range
-10 .. 10. Specify another interval over the x-axis, e.g. the interval [-2, 4]:

> plot(p, x=-2 .. 4);

8
6
41
2
S A A A

Note that in Maple, the boundaries are separated by two dots (. . ). You can also specify the
y-range:

> plot(p, x=-2 .. 4, y=-1 .. 7);
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The plot function accepts a lot of so-called plot options, one of the most important is
scal i ng=const r ai ned, which tells Maple to use equal x- and y-ranges.

> plot(p, x=-2 .. 4, y=-1 .. 7, scaling=constrained);

For other plot options, check:

> ?pl ot, options

Algebra

You can convert a polynomial to linear factors - where appropriate - with the factor function,
passing the expression in brackets.

> factor(p);

(- 1)°

Multiply out the result with expand, thus regaining the original polynomial. To specify the last
result Maple has computed, use the percentage sign. (In Maple V Release 4 and earlier versions,
use the quotation mark " instead of %)
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> expand( % ;

}(2—2;{+’1

solve determines solutions to equations. To get the roots of p, specify the equation as the first,
and the indeterminate in p as the second argument.

> sol ve(p=0, x);

1,1

Maple returns the solution twice for if you convert p to linear factors, you get two zeros -1:
X2-2%x+1 = (x-1)*(x-1).

If you want to receive numerical values, use eval. To determine the value of p at point x=0, enter:
> eval (p, x=0);
1

You can also directly assign values to variables such as x:

Thus Maple automatically returns:
> p,
1

However, p is no longer available as the symbolic expression x2-2x+1, but as the numerical value

1. If you want to do further computation with the original symbolic polynomial p = X2-2x+1, you
have to reset/unassign x:

Systems of equations

Maple supports solving systems of equations.
Suppose you have two equations:

> eqgl := 3*x-2*y=8§;

eql =3x-2y=8
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> eqg2 = 5*x-3*y=4,
eq2 =5x-3y=4

Pass the two equations in one set as the first argument, and the variables to be solved for as
another set to solve:

> solve({eql, eqg2}, {x, vy});

{y =-28, x=-16}
Symbolic manipulations
To simplify (more or less) complicated expressions, use simplify:

> sinplify(sin(x)”2+2*cos(x)"2);

2
cos(x)™ + 1
You can isolate variables in an equation:

> i sol ate(x*y+2=0, vy);

1
y=-2-

collect collects all the coefficients with the same rational power of an indeterminate together:
> col lect(5*x + a*x + 1, Xx);
G+a)x+1
normal seeks for the common denominator:
> normal ((2*x-1)/(x-2)-(x+1)/(x+2));

¥ix+4)
(=21 {x+2)

Hint: To easily execute manipulations, right-click into the output (the fraction) and choose the
desired action (this works with Maple V Release 5.X and later versions):
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[nteger Functions
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Simplifizations
Converzsions
Sortz

Flots

A i i Db

Defining functions
You can also define functions very easily. This is done with the operator - >.
>f 1= x -> (x+1)*(x-1);
fi=x->x+1)(x-1)
You can apply all Maple functions to self-defined functions:
> expand(f(x));

}{2—1

To get function values, pass arguments (here: x-values):

> f(1);

> f(2);

3
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Note that Maple is a symbolic computer algebra system. You can either enter floating point values

like in a pocket calculator and receive floating point results,
> f(0.5);
-.75
or use symbolic values such as a fraction and get an accurate, symbolic result.

> f(1/2);
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Defining a function prevents you from using the eval function. Plots:

> plot(f(x), x=-5 .. 5, y=-2 .. 10);

Interceptions with the line y=2:

> solve(f(x)=2, x);

Yoo

You can also print a table of function values using a for-loop. Here, all function values in the
interval [-2, 2] (from -2 to 2) with step (step) 0.5 are printed:

> for i from-2to 2 by 0.5 do
> f(i)

> od;

0.
1.25
3.00

You can also print the x-values (here expressed by the loop variable i) along with the function
values:

> for i from-2to 2 by 0.5 do
> i, f(i)
> od;

-2, 3
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-1.5,1.25
-1.0, -0.
-5,-.75
0., -1.
.5,-.75
1.0, 0.
1.5,1.25
2.0, 3.00
Calculus
To get the limits use the limit function. Here, we determine the limit of an expression at x=1:
> limt((x*2-1)/(x-1), x=1);
2
The behavior in the infinite is determined by passing the constant infinity instead of a point.

> limt(n/(n+l), n=infinity);

diff computes the (first) derivative.

> g = x"3-x"2-x-1,

g::}ig—xz—x—’l
> diff(g, Xx);

352 _ 2y 1

As with all other Maple commands, you can apply diff to the output again (in Maple V Release 4
and earlier, use the double quote " instead of the percentage sign).

> diff(% x);
Bx— 2

For the nth derivative, put a dollar sign and the integer n behind the indeterminate, for the 2nd
derivative:

> diff(g, x$2);
Bx-2
For the 3rd derivative:
> diff(g, x$3);
6

Integration/anti-differentiation is performed with int:
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> int(g, X);

14 13 12
4}(—3}(—2}(—}(

int also determines the area under a curve between two points. Pay attention to the two dots
separating the boundaries.

>int(g, x=1 .. 3);

16
3
Series expansion of an expression at a point:
> series(sin(x), x=0);
13, 1.5 6
:-{—6}{ +’IEDK + O )

Differential equations are solved with the dsolve function. The diff function is used to define the
differential equation:

> dsol ve(ode, y(x));

Yix) = }<2+_C’l

Initial values can be given by passing both the ODE and the value as a set in curly brackets.
> dsol ve({ode, y(0)=1}, y(x));

y(xj:}{2+’l

Linear Algebra

At first, we restart Maple so that all values are cleared.

> restart:

Vectors are defined with arrows that enclose the vector components:

> vl =<1, 2, 3>
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> v2 = <a, b, c>;
a
w2 = h
C
You can add and subtract these vectors:
> vl + v2;
1+a
2+ b
A4
> vl - v2;
1-a
2—b
A-r

file:///El/homepage/mpl crashcourse.htmm

The LinearAlgebra package contains a lot of functions that allow you to work with vectors and

matrices. You have to initialize this package before using its functions:

> W t h(Li near Al gebra):
Dot product:

> Dot Product (vl, v2);

a+2b+3c
Cross product:
> CrossProduct (vl, v2);
2c=-3Db
Ja-c
b-24a
Multiplication of a vector and a scalar:
> ScalarMultiply(vl, s);
5
25
3s

Matrices are defined like vectors using the arrow operators. Note that pipes separate the
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coefficients in a matrix row.

> A

<<a | b> <c | d>>;

\Y
vy)
1

<<e | f> <g | h>>;

Addition:

> A + B;

Subtraction:

> A - B;

[a+e b+f}
c+g d+h

[a—e b—f}
c—g d-h
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Non-communitative multiplication is performed with a dot, whereas scalar multiplication is done

with the multiplication operator *.

> A . B;

|

> A* s;

Determinant;

> Determ nant (A);

ae+hbg

ce+dq

ad-bc

af+bh
cf+dh

Lets define a new matrix A, you do not have to restart Maple or unassign A before:

> A=<
> <1 ] -3 ]| 1.5 | -1>,
> <-2 | 1| 3.5]| 2>,
> <1| -2 1] 12| 2>
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> 3] 1] -1] -3>

> >
[ 1 <% “TE 7]
2 e 2
A=
¥ a3 g 2
|3 ] = =3
>Cc :=<-10.4, -16.5, 0, -0.7>;
(104
65
i
[
e

To get solutions to a system of equations, apply the LinearSolve function:

> Li near Sol ve(A, c¢);

[ .808000000000000274 |
- 183999999999995914
-5.87999999999999900
| 2.93999999999999994 |

Getting help

Maple features an extensive online help that will answer all your questions.
Type

> ?newuser, user nenu

in the input line for the ‘Maple New User’s Tour Main Menu‘. As opposed to statements, when
calling the online help, do not terminate the input with a semicolon.

If you would like to have more information on a specific Maple function, e.g. the solve command to
determine solutions, type:

> ?sol ve
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In general:

> ?commuand

E Maple 7 - [solve] Hii=] B3

T3 5@ Fle Edit ¥iew ‘window Help =18 =] = 8] %]
&[] [ [&] [«]=] [E[1 =] 7]

iP' Heading 1 j IT-m-':;il-=-=.--|-':-.'.-rn.3u j I'IH -

[ntroduction | Alaebra.., | LinEearF|.4r'u:l:i|:|r1e‘:_l function

Getting Started ] | B asic Matherma—] | LinearJperatari ] | identity

YWhat's Mew. .. = ||Calculuz... * || lingzole * |lineq

solve - Solve Equations
Calling Sequence

solve({eqn, var)

solve({eqgns, vars)

|
Parameters
eqn - ah equation, mequality of procedure
eqns - a set of equations or mequalities
var - (optonal) a name (unknown to solve for)
vars - (optonal) a set of names (unknowns to solve for)
Description

= The solution to a single equation egn solved fora
single unknown var is returned as an expression. To  ~

[ Time: 915 |Bytes 375M | Available: 238M

Search’. After entering the term or keyword, press the ‘OK* button.

| rtroduction

H ElmEr i Eartes! Eitart]
Mew Lzer's Tour

What's Mew

Uzing Help

Glozzany

Eull Test Search... Q

Histony.,

Save to Databaze. .
Remove Topic...

Balloon Help

Reaizter Maple 7...

dbout Maple 7.,
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Also try have a look at the ‘Help menu item*, it features the entries ‘Topic Search® and ‘Full Text
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Topic Search |
Tapic: [differentiation |
Matching Topics: Apply |
Abbrechen |
[~ Same window ¥ suto-search

Questions ?

Any questions ? Then send an E-mail to alexander.f.walz@web.de.

Download
Download this introduction:

e as a Maple MWS file: mplcrashcourse_mws.zip for Maple V Release 5 through Maple 7.
e as a PDF file: mplcrashcourse pdf.zip.
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